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ARTICLE 

You Too Can Be A Programmer 

D 
on’t know anything about 

computer programming? 

Have no desire to learn a pro-

gramming language? But, if someone 

else would do all the work, and at no 

cost to you, would you like to create 

a custom utility program? Well, may-

be you won’t find some one to do the 

programming for you but you can 

easily convince an AI chatbot to cre-

ate an application. Welcome to the 

world of vibe coding! 

 

The term, vibe coding, was coined by 

Andrej Karpathy, one of the co-

founders of OpenAI, in a post on X 

on February 2, 2025 (https://x.com/

karpathy/

status/1886192184808149383.) His 

post starts with: “There's a new kind of 

coding I call ‘vibe coding’, where you fully 

give in to the vibes, embrace exponentials, 

and forget that the code even exists.” 

He goes on to explain that he just 

talks to an AI bot and asks it to devel-

op a program to do a specific task. 

He doesn’t look at the resulting code. 

He simply runs the program as pro-

vided by the bot and refines the 

prompt if the result is not quite what 

was expected. If an error message is 

displayed, he copies and pastes it into 

the prompt and lets the bot analyze 

the issues and come up with a fix. 

Using this rinse-and-repeat strategy, 

the bot modifies the code until the 

program performs the requested task 

successfully. 

I just see stuff, say stuff, 
run stuff, and paste stuff, 
and it mostly works 

Andrej Karpathy 
 

So, you don’t need to look at the 

code, you don’t need to know any-

thing about programming in general, 

nor have any knowledge of the specif-

ic language being used. You just give 

the AI bot a prompt indicating what 

you want the application to do, and 

follow-up with more instructions as 

and when necessary. So, using this 

technique, you can be a computer 

programmer! 

 

Now, even though you are putting 

AI, and one of its large-language 

models, to work, you are probably 

not going to build a clone of Mi-

crosoft Office or Adobe Photoshop 

and make your fortune. Nor are you 

likely to develop in-depth program-

ming skills, especially since (in “pure” 

vibe coding) you don’t review the 

resulting code. Rather, this technique 

is more suited to developing a small 

application to complete a specific task 

with a very limited scope. Neverthe-

less, the exercise can be fun, and the 

result can be very useful. 

 

So, how can vibe coding assist us in 

our day-to-day computer operations? 

Some examples might be: 

 

 build a website to showcase your 

photos, 

 create a VBA macro to automate a 

process in Word or Excel, 

 

 generate a batch file or PowerShell 

script to automate a process in 

Windows, or 

 

 develop a program in Python, 

C++, JavaScript, etc. to... 

 

The possibilities are endless. The final 

product will be what you want the 

app to do! 

 

As a concrete example, consider gen-

erating a macro to process the log file 

produced when running PatchMyPC 

in order to extract a list of the in-

stalled applications that have been 

successfully updated. My use for such 

a macro is to create text documenting 
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Next Meeting 
 

Wednesday, March 11th
 

NAS in the Home Environment 

Speaker: Bill Van Dijk (OPCUG) 

 

A Network Attached Storage (NAS) system is typically a 
small file server, running on a local area network (LAN), 
providing access to shared documents, photos, videos, and 
streaming services for several connected devices.  In this 
presentation, Bill Van Dijk will provide an overview of 
setting up a NAS unit in the home environment and de-
scribe some of the different capabilities that make such 
systems attractive for regular computer users. 

Bill is a long-time member of the OPCUG, starting back in 
the mid-80s, and served for a couple of years as the club’s 
Finance Director.  Bill’s background is mostly in the me-
chanical field but with a very strong interest in electronics.  
He was the Year 2000 project manager for the City of Kana-
ta during the Y2K period, and subsequently worked as pro-
ject manager for fleet services at the City of Ottawa. 

 

This meeting will be via Zoom video conference. 

Join us at https://tinyurl.com/opcug-meeting. The Zoom 
link will be live at 7:15 pm. The meeting will begin at 7:30 
pm. 

CALENDAR 

Event Date Time and Venue 

Next Monthly Meeting Wednesday, March 11th 
7:30 pm via Zoom video conference: https://tinyurl.com/opcug-meeting 
See all our scheduled monthly meetings here. 

Next Q&A Session Wednesday, February 25th 
Q&A sessions are held weekly except on monthly meeting nights.  
Join us most Wednesdays at 7:30 pm for weekly Q&A. 

Next OPL Presentation Tuesday, February 24th See all our presentations with links to the OPL here. 

 

Coming Up… 
 

25 Feb  
Next weekly Q&A session 

03 Mar (Tuesday, Bonus Presentation #2, see next page for details) 
Armchair Travel: Beautiful British Columbia (Lynda Buske) 

08 Apr 
Restoring old photos (Lynda Buske) 

13 May 
Ask the Geeks! (test our in-house “experts” with your questions) 

10 Jun (6 PM) 
Annual Pizza Night (Britannia Park, details to follow) 

09 Sep 
Artificial Intelligence (AI) (Chris Taylor) 

14 Oct 
Vibe Coding Competition (various participants, see related article p. 1) 

 

See all our scheduled events here. 

 

OPCUG Presentations at the OPL: 
 
Tuesday, 24 Feb, 6:00 pm - 8:00 pm 
Protecting your PC (Chris Taylor) 
Munster Branch 

Thursday, 26 Feb, 6:00 pm - 8:00 pm 
Whoa, backup! Effective strategies for keeping your computer files safe 
(Chris Taylor), Manotick Branch 

Saturday, 28 Feb, 2:00 pm - 4:00 pm 
Fun with fonts – the art and science of typography (Chris Taylor) 
Blackburn Hamlet Branch 

Monday, 02 Mar, 6:00 pm - 7:00 pm 
Armchair travel: Ireland & Scotland (Lynda Buske) 
St. Laurent Branch 

Thursday, 05 Mar, 10:30 am - 11:30 am 
Armchair travel: Newfoundland (Lynda Buske) 
Greenboro Branch 

 

See all our presentations with links to the OPL here. 

https://opcug.ca/events/nas-in-the-home-environment/?occurrence=2026-03-11
https://tinyurl.com/opcug-meeting
https://opcug.ca/mec-category/regular-monthly-meetings/
https://opcug.ca/events/qa-weekly-session/
https://opcug.ca/qa/
https://opcug.ca/mec-category/opl-presentations/
https://opcug.ca/events/qa-weekly-session/
https://opcug.ca/events/bonus-presentation-2-armchair-travel-beautiful-british-columbia/?occurrence=2026-03-03
https://opcug.ca/events/restoring-old-photos/?occurrence=2026-04-08
https://opcug.ca/events/ask-the-geeks/?occurrence=2026-05-13
https://opcug.ca/events/artificial-intelligence-ai/?occurrence=2026-09-09
https://opcug.ca/events/vibe-coding-competition/?occurrence=2026-10-14
https://opcug.ca/#upcoming
https://opcug.ca/mec-category/opl-presentations/


 Page 3  

 Volume 43,  Number  3  

Bonus Presentation #2 
 

Armchair travel: Beautiful British Columbia 

with Lynda Buske, OPCUG 

 

Enjoy photos and narration of British Columbian coastal, interior and island  

beauty including stunning gardens and birds. Some are from the 1920s! 

Learn a few photo tips from Lynda along the way! 

 

The zoom lecture will take place on Tuesday, March 3, at 7pm EST & will last 

approximately one hour. 

 

Hosted on Zoom at https://tinyurl.com/opcug-bonus02 

If the above easy-to-remember link doesn't work, you can use: 

https://us02web.zoom.us/j/86431194545?pwd=UFpQyxJprpbaY3gTopKS2Uy5apawsz.1 

 

Or join by entering the meeting ID in the Zoom app 

    • meeting ID: 864 3119 4545 

    • passcode: opcug 

CLUB STUFF 

Vibe Coding Competition (non-members are welcome to participate) 
 

OPCUG will offer two prizes for submissions using vibe coding in a competition to be held 
at the club’s monthly meeting in October. Holding the competition will be subject to hav-
ing multiple entries submitted. The use of vibe coding will be on the honour sys-
tem. For those providing entries, there will be two prizes offered: (1) the most useful 
product, and (2) the best presentation of the development process. Note that the project 
doesn’t have to be successful for this second portion of the competition. Stories of trials 
and tribulations, and even abysmal failure will be happily accepted. So, get started on 
your vibe-coding project. You have lots of time to refine both the code and the associated 
presentation. When you are ready, submit your entry to the competition to:  
SuggestionBox@opcug.ca 

 

 

 

Membership Drive 

October 14th Meeting 

 Details at                                                             

, 2026 

https://opcug.ca/events/bonus-presentation-2-armchair-travel-beautiful-british-columbia/?occurrence=2026-03-03
https://tinyurl.com/opcug-bonus02
https://us02web.zoom.us/j/86431194545?pwd=UFpQyxJprpbaY3gTopKS2Uy5apawsz.1
https://opcug.ca/events/vibe-coding-competition/?occurrence=2026-10-14
mailto:SuggestionBox@opcug.ca
https://opcug.ca/join-or-renew/
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Creating a PowerPoint video of photos 

by Lynda Buske 

I recently shared some slides in Q&A on how to create a 

PowerPoint deck of photos to which you can add music.  

https://opcug.ca/qa_recordings/20260204_PowerPoint.pdf 

You can make a mini movie of your vacation pics or share a 

collection of photos of your favourite topic! You can also 

create a deck that could run at a party or a celebration of life 

with continuous looping. I would not add music to this as it 

could get pretty tedious to hear the same song over and over 

again. 

To start, click on the Design tab and pick the size of Power-

Point slide you want via Slide Show tab. If you don’t want 

plain white, choose one of the templates shown or choose 

your own background colour under Format background tab. 

You can choose your background colour later if you wish. 

Typically, I will insert the images and choose a colour I think 

will work well with all of them. But you can have a different 

colour for each slide and even use the eye dropper option to 

click on a colour in each photo that you think would make a 

good background. Great feature! 

Next, go the Home tab, click on New Slide and select Blank. 

You can repeat this or copy and paste the first blank slide 

multiple times. 

Now go to the Insert tab on the top menu and click on the 

Picture icon. This will allow you to select images from your 

device or from OneDrive (if you have that set up) to find 

your images stored on-line. You can click on the images one 

at a time or select groups using the Shift-click or Ctrl-click 

shortcuts. They will all appear in the first slide. Select and 

cut (Ctrl X) each photo and paste it (Ctrl V) onto a blank 

slide. 

You can of course have two or three images per slide and 

can adjust the size by dragging the corners. The aspect ratio 

will be maintained. You can overlap them and adjust by 

right clicking on the image and using the Bring to front or Send 

to back buttons. 

If you wish to frame your images, click on a photo and then 

go to the Picture Format tab. This will give you many options 

A guide to digital photography for computer enthusiasts. After the click of your camera, you’re only half done! 

THROUGH THE LENS 

Read all of Lynda’s articles here. See her presentations at the Ottawa Public Library (select Lynda Buske as Organizer). 

for framing. You can then click on the Home tab, then dou-

ble click on Format Painter and that will allow you to apply 

the same frame to the images in all your slides by just click-

ing once on each photo. 

To have your slides automatically advance, go to the Tran-

sition tab, choose the transition style you like and then 

choose how long that transition will last. For example, if 

you use Reveal transition and set Duration (on the far right) 

to 2 secs, it will take that long to fade out the first image 

and bring in the next. Then decide how long you want the 

viewer to see that image before it advances to the next 

slide. In the Advance slide section, click on the After box. 

Then set the number of seconds. Note: If you are adding 

music, make sure you include both the transition time and 

the advance time to calculate exactly how long the slide 

show is. Or play it through while running a timer. 

To loop your images, go to the Slide Show tab then Setup 

Slide Show. Click on the box that says Loop continuously 

until ‘Esc’. 

To add music to your presentation, go to the first slide, 

click on Insert tab, Audio, then Audio on my PC. Select your 

music and hit enter. The slide will show an audio icon at 

the bottom corner but that is not visible while in slide show 

mode. To cut or fade the music, click on the audio icon to 

bring up the Playback tab. From there you have options to 

fade your music in or out. 

Then all you have to do is hit slide show and let it run! 

 

 

https://opcug.ca/qa_recordings/20260204_PowerPoint.pdf
https://opcug.ca/digital-photography/
https://opcug.ca/mec-category/opl-presentations/
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Color Displays - 2025 
 
By: Tom Burt, Vice President 
Sun City Summerlin Computer Club 
https://www.scscc.club 
tomburt89134 (at) cox.net 

 

LCD (Liquid Crystal Display) color monitors and TVs have 

now superseded the old tube-based displays. Resolutions 

have become incredibly high, offering amazingly fine-

detailed color images. In August 2015, I wrote about the de-

tails of HOW these LCD color screens operate to display the 

images we now take for granted. 10 years later, much of the 

display technology we use still operates the same way, using 

24-bit color displays. However, as always, there have been 

advances in display technology, and prices have come down, 

bringing near theater-quality viewing to our home TVs and 

computer monitors. 

 

An LCD display is a rectangular array of dots (pixels). 

Screens are characterized by the size and shape of this array. 

Older displays used a ratio of 4 pixels wide to 3 pixels high (4 

by 3). Most displays and TVs now use the ratio 16 pixels 

wide by 9 high – the standard for high-definition TV. Howev-

er, other ratios such as 21 by 9 are used as well. A typical 24-

inch computer display screen will be 1920 pixels wide by 

1080 pixels high, giving 2,073,600 pixels in total. The latest 

“Ultra HD / 4K” HDTVs have doubled this resolution to 

3840 pixels wide by 2160 pixels high, giving almost 8.3 mil-

lion pixels in total. 

 

 

 

Hisense 75” U6 UHD (4K) QLED, 1 billion colors, HDR 

 

The above image was taken from a “Black Friday” ad on 

Amazon. The TV shown was priced at $750. It features 4K 

resolution, High Dynamic Range, wide-color gamut, Quan-

tum Dot LED technology and an AI-based up-scaler to con-

vert standard definition and regular HD content to the 4K 

resolution. Some of this technology was very expensive 10 

years ago and some had not yet come to the market. We’ll 

elaborate on these new technologies as we go. 

 

APCUG 
In the older, but still common 24-bit (3-byte) color 

schemes, each individual pixel of an LCD display is made 

up of 3 separate sub-pixels – one for each of the three pri-

mary colors: red, green and blue. When these sub-pixels 

are illuminated in various intensities (from 0 to 255), that 

pixel can be made to display any of 16,777,216 distinct 

colors. So, a high-definition (1920 by 1080) LCD color 

screen with 24-bit color actually contains 6,220,800 indi-

vidually addressable sub-pixels. 

 

In the newer 30-bit color schemes, each individual pixel of 

an LCD display is again made up of 3 separate sub-pixels – 

one for each of the three primary colors: red, green and 

blue. These sub-pixels are illuminated in various intensities 

(from 0 to 1023). A pixel can display any of 1,073,741,824 

distinct colors. So, a 4K LCD color screen with 30-bit color 

actually contains 24,883,200 individually addressable sub-

pixels. 

 

A liquid crystal sub-pixel operates like a shutter. It can be 

completely transparent, allowing all light from behind it to 

shine through or it can be completely opaque, allowing no 

light from behind to shine through. To illuminate the col-

ored sub-pixels, behind the LCD matrix is a light source. In 

low priced displays, this backlight comes from a pair of 

fluorescent lamps at the edges. In QLED displays, the 

backlight comes from an array of white LEDs. 

 

An LCD sub-pixel’s opacity is controlled by how much 

current is passing through it. In 24-bit color displays the 

current level for each sub-pixel can be varied in 256 discrete 

levels (0-255), giving 256 possible intensity levels for each 

of the three colors making up a pixel. In 30-bit color dis-

plays, the current level can be varied in 1024 discrete levels 

(0-1023). To the human eye, adding together combinations 

of red, green and blue in various intensities gives rise to the 

full spectrum of colors. 

      Red (255), green (255), blue (255)     Red (192), green (192), blue (192) 
 

Above are two diagrams of blending of colors in 24-bit col-

or space. The left has all three colors at their brightest level 

(255); the right has all three colors at 75% of their brightest 

level (192). 

(Continued on next page) 

https://www.scscc.club
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Within an LCD display device is a block of memory that is 

used as a display frame buffer. In 24-bit color that frame 

buffer has one 8-bit byte per sub-pixel (i.e. 3 bytes per pixel) 

allowing for an intensity range of 0 to 255 for red, green 

and blue for each pixel: 

 

 

 

 

In 30-bit color that frame buffer has one 10-bit field per sub-

pixel (i.e. 4 bytes per pixel) allowing for an intensity range 

of 0 to 1023 for red, green and blue for each pixel: 

 

 

 

(The actual physical format of 30-bit color data in the buff-

er uses a more complex packing scheme to optimize space 

but effectively is as shown above.) 

 

A controller chip scans this frame buffer one pixel at a time 

and drives the current flows to the screen’s 6.2 million 

(HD) or 25 million (4K) sub-pixel elements to control their 

opacity. On the LCD screen you see the entire colored im-

age with a range of 16.8 million or 1 billion colors. The 

entire display is typically refreshed (re-scanned) 60 or 120 

times a second, though higher refresh rates are often found 

in monitors for gaming. 

 

High Dynamic Range and Wide Color Gamut 
Most new HDTVs and many computer monitors now use 

the 30-bit color scheme which allows for 4 times as many 

red, green, blue color levels. In conjunction with separately 

controlled mini-LED backlighting, black pixels can be 

made blacker and white pixels can be made brighter. Put-

ting these together allows the LCD display to show much 

more vivid colors and subtler interplay of light and shad-

ow. 

 

Above is an example of the difference between a standard 

HD picture (left) and one displayed with high dynamic 

range and wide color (right). 

 

 

Color Displays   (Continued from previous page) Quick Tip 82: Mouse speed 

by Chris Taylor 

I s your mouse too fast? Does it jump a huge distance with a 

slight movement, making it difficult to position it precisely? 

Is it too slow? To move a large distance, do you have to drag it 

right across the desk, pick it up, move it back to the other side 

of the desk, put it down and drag it again, and again, …? 

Press Win+i to open Settings. Navigate to Bluetooth & devices 

> Mouse > Mouse pointer speed. 

Drag the slider left (to slow down the mouse) or right (to speed 

up the mouse). The effect takes effect immediately. 

 

2025 Financial Review 

I  have completed my review of the OPCUG's financial records 
for 2025 and found no errors or omissions.  I did make some 

suggestions for improving the Treasurer's Report.  As well I initi-

ated a new cross-check of the Membership dues collected and the 
Membership database, which had not been possible in previous 

years.  It is my assessment that the books submitted to me by the 
treasurer represent a complete and accurate accounting of the 

club's financial activities in 2025. 

-Richard Aylesworth 

 

Treasurer's update to last month's report:  As per the review's 

findings, a refund of $40 for an over-payment of a meeting ex-
pense in 2024 was moved from 2025 to 2024, correcting the total 

for 2025 from $302.84 to $342.84. The remaining totals are un-

changed. 

-Jocelyn Doire 



 Page 7 

 Volume 43,  Number  3  

the process that I could easily add to the file that I use to keep records all of the maintenance operations on my computer’s 

operating system, installed applications, and data files. 

 

My practice has been to run PatchMyPC only occasionally which usually results in several software packages being updat-

ed in a single session. I then use Notepad++, an open-source text editor, to manually extract the list of updates from the 

PatchMyPC log and paste the results into my maintenance file. This sort of repetitive task is an ideal candidate for automa-

tion and, since the process is well defined, it is also very suitable as a vibe-coding project. And, since it’s a fairly simple task, 

almost any AI engine should be able to develop an appropriate macro for Notepad++. 

 

The PatchMyPC log file typically contains many lines of text while only one line per application denotes a successful up-

date. 

Figure 1. Extract from the file PatchMyPCHomeUpdater.log 

 

Note that, in the highlighted line, the application’s name, Shotcut, is preceded by the text string “INFO Application “ and 

is followed by the text string “ has been successfully updated”. It should be apparent that we can identify the name of each 

application that is recorded as having been updated by PatchMyPC by simply extracting the sub-string between these lead-

ing and trailing-strings. 

 

My initial though was to have Microsoft Copilot develop a macro for the Notepad++ text editor; however, it transpired 

that the macros available in Notepad++ have no capacity to contain a loop with which to process records for multiple ap-

plications. Instead, Copilot suggested creating a Python script for this task. 

 

My first step, therefore, was to give Copilot a prompt detailing precisely what I wanted the script to achieve. The starting 

point is that the log file created by PatchMyPC will have been opened and be the active tab in Notepad++. The Python 

script will be available within Notepad++ and can be invoked to work on the text in the active tab. The basic requirement is 

that the script should search through the lines of text, identify any line indicating that a package has been updated, and 

write the name of this package to a new line in a second tab. A further requirement is that a header line be included in the 

second tab in the form that I use for related entries in my maintenance log, i.e. ”Windows - Ran PatchMyPC to update the 

following:” The initial prompt is shown in Figure 2. 

Figure 2. In initial prompt for Microsoft Copilot 

 

You Too Can Be A Programmer   (Continued from page 1) 

(Continued on next page) 
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(back to Table of Contents) 

Copilot produced a Python script in response to this prompt. However, since we are vibe-coding, we won’t look at the code 

developed. Instead, we need to identify how to load and run the script in Notepad++. The obvious solution to this is to 

simply ask Copilot this specific question. 

Perhaps the simplest answer given is that, if a Python script is already available as a .py file, to store this file in  

%AppData%\Notepad++\plugins\Config\PythonScript\scripts\ and it will then appear in Notepad++’s Scripts menu. 

Opening File Explorer and pasting %AppData%\Notepad++\plugins\Config\PythonScript\scripts\ into the address bar 

shows that, on my system, this folder is actually located at 

C:\Users\toaster\AppData\Roaming\Notepad++\plugins\Config\PythonScript\scripts.  

So, what I need to do is to use the Copy button in Copilot to obtain the text for the script, paste this into Notepad++, and 

then save the script as a file named ExtractedUpdatesScript.py to the scripts folder. 

With the file PatchMyPCHomeUpdater.log open, the script can be run by navigating to Plugins > PythonScript > Scripts > 

ExtractedUpdatesScript. The result is that a second tab is created with the header line followed by a list of software packag-

es that have been updated by PatchMyPC. 

My intention was to be able to copy and paste this text directly into my maintenance log file. However, I realized that I had 

omitted to ask for spaces to be added in front of each updated software listing which is my usual format for such entries. 

However, remember that it’s easy to give Copilot a follow-up prompt to ask it to modify the script to add three spaces to 

each relevant line of text. A new script is developed that can then be saved to overwrite the initial script file. The final result 

is a block of text that can be added to my maintenance log (Figure 3). 

Figure 3. Results of running ExtractedUpdatesScript.py 

 

The requirements for the sample script are relatively simple but its development, exclusively through vibe coding, shows the 

power of the use of AI technology for such purposes. Clearly, one can actually review the code that has been produced and 

it’s also very easy to ask the AI bot to explain how the code works. Generally, this provides a detailed, line-by-line descrip-

tion which can be extremely useful for anyone who is interested in learning a programming language. 

So, give some thought to an application that you could make use of and give vibe coding a try. Most AI engines will develop 

custom code on request. The process can be interesting and the results can be very useful. 

 

 

 

 

 

 

You Too Can Be A Programmer   (Continued from previous page) 

Vibe Coding Competition (non-members are welcome to participate) 

 

OPCUG will offer two prizes for submissions using vibe coding in a competi-
tion to be held at the club’s monthly meeting in October. Holding the competi-
tion will be subject to having multiple entries submitted. The use of vibe 
coding will be on the honour system. For those providing entries, there will 
be two prizes offered: (1) the most useful product, and (2) the best presenta-
tion of the development process. Note that the project doesn’t have to be suc-
cessful for this second portion of the competition. Stories of trials and tribula-
tions, and even abysmal failure will be happily accepted. So, get started on 
your vibe-coding project. You have lots of time to refine both the code and the 
associated presentation. When you are ready, submit your entry to the com-
petition to: SuggestionBox@opcug.ca 

 

 

 

https://opcug.ca/events/vibe-coding-competition/?occurrence=2026-10-14
mailto:SuggestionBox@opcug.ca
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O T T A W A  P C  N E W S 
 
Ottawa PC News is the newsletter of the Ottawa PC Users’ Group (OPCUG), and 
is published monthly except in July and August. The opinions expressed in this news-
letter may not necessarily represent the views of the club or its members.  

Member participation is encouraged. If you would like to contribute an article to Otta-
wa PC News, please submit it to the newsletter editor (contact info below).  

To receive the monthly newsletter by email, send an email to:  
opcug-newsletter+subscribe@googlegroups.com  (leave subject and body fields blank) 
You do not need to create a Gmail or Google Groups account. 

To subscribe to other OPCUG Google Groups member services, go to: 
https://opcug.ca/google-groups-how-to/  

 

Group Meetings 

OPCUG meets on the second Wednesday in the month, except July and August, at 
the Riverside United Church, 3191 Riverside Drive, Ottawa. Parking is free at the 
church. OCTranspo bus #90 stops nearby. Details at https://opcug.ca/venue/. 
 
NOTE: Until further  notice, all our  events are via video conference.  
Details at https://opcug.ca/venue/ . 
 
 

OPCUG Membership Fees:  $20 per year 
Mailing Address:   3 Thatcher St., Nepean, Ontario, K2G 1S6 
Web address:   https://opcug.ca 
Follow us on Facebook:  https://www.facebook.com/opcug 
Follow us on X:   https://x.com/opcug 
 
 
President and System Administrator 
 Chris Taylor       chris.taylor@opcug.ca 
Treasurer 
 (Mr.) Jocelyn Doire jocelyn.doire@opcug.ca 
Secretary 
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O T T A W A  P C  N E W S 

 

Ottawa PC News is the newsletter of the Ottawa PC Users’ Group (OPCUG), and is 

published monthly except in July and August. The opinions expressed in this newsletter may 

not necessarily represent the views of the club or its members.  

Member participation is encouraged. If you would like to contribute an article to Ottawa PC 

News, please submit it to the newsletter editor (contact info below).  

To receive the monthly newsletter by email, send an email to:  

opcug-newsletter+subscribe@googlegroups.com  (leave subject and body fields blank) 

You do not need to create a Gmail or Google Groups account. 

To subscribe to other OPCUG Google Groups member services, go to: 

https://opcug.ca/google-groups-how-to/  

 

Group Meetings 

The OPCUG holds its regular monthly meetings on the second Wednesday in the month via 

video conference (details at https://opcug.ca/venue/). 
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Q&A IS ON-LINE! 
Weekly! 

 

Since the pandemic, the OPCUG has 

been holding weekly Q&A sessions 

in Zoom video-conferences. 

Join us every Wednesday (except on 

regular monthly meeting nights) at 

7:30 pm to discuss computer issues. 

Questions (and answers) on any com-

puter-related issue are welcome.  Or, 

do you have a favourite computer 

program or topic that you would like 

to share with the group?  Send your 

questions, answers, or the details of 

what you would like to share to:  

SuggestionBox@opcug.ca 

Everyone is welcome to attend Q&A 

sessions and to ask questions about 

their specific computer-related prob-

lems.  Join us at: https://

tinyurl.com/opcug-meeting (if you 

use the Zoom client, the meeting ID 

is 924 9556 0898 and the password is 

opcug). 
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